
Color and More 
In this lesson, you'll evaluate an image in terms of its overall tonal range (lightness, 
darkness, and contrast), its overall balance of color, and its overall appearance for areas 
that require retouching. You'll then make adjustments to the image based on your 
evaluation. It's fun to compare the before and after images to see just how much you can 
improve an image.  

As with many projects, you need to review some basics and do some preparation before 
you begin. Your goal is to improve the tonal range and color of an image. This requires a 
brief review of color basics.  

A prerequisite to this lesson is a review of the "Understand Color Basics" section in 
Lesson 3 of the Beginning Adobe Photoshop CS2 course of this series.  

Color basics  
You'll find it helpful to review some basic color principles to give you a basis to 
understand the color adjustments you'll make in Photoshop. When digital cameras and 
scanners capture an image, the image data includes information about the intensity of the 
light. Digital cameras and scanners also use filtering methods to change the light into the 
three color components of red, green, and blue. The three separate color components are 
then combined into a color image composed of red, green, and blue pixels. For basic 
information about how digital cameras and scanners work, go to the How Stuff Works 
Web site and search for digital camera and scanner.  

This lesson focuses on images in the RGB (red, green, blue) mode, which is based on the 
additive color theory. In the additive color theory, the range of colors is based on the 
spectrum of visible light. For example, you can see this spectrum represented by the color 
slider bar in the Photoshop Color Picker and the color spectrum bar in the Color palette. 
If you rotate the color slider bar, it looks similar to the familiar colors reflected from a 
prism.  

 

If you bend the color spectrum in a circle, you have the color wheel. The center of the 
circle where all the colors are added together is white. This is why it is called additive 
color theory.  



 

Notice the positions of the colors on the color wheel. This makes it easy to observe the 
color relationships and the color opposites. For example, cyan is opposite red and it's 
made from the two adjacent primary colors of blue and green. The warms colors are on 
one side of the wheel and the cool colors are on the other side.  

Color modes  
The RGB color mode is just one of the color modes that Photoshop supports. If you look 
at the Color Picker with its default settings, as shown in Figure 2-1, in addition to RGB, 
you'll see CMYK (cyan, magenta, yellow, black), HSB (hue, saturation, brightness), and 
LAB (luminance, green to magenta, and blue to yellow).  

 
Figure 2-1: Photoshop Color Picker.  



These color modes are based on the different color models. The CMYK color model is 
based on the subtractive color theory of the four-color inks used for the four color 
separation process for print. In this model, when you subtract color, the resulting color is 
white and when you add all the colors, the resulting color is black. The HSB color mode 
is based on the HSB color model. Most of you are familiar with RGB, CMYK, and HSB.  

The LAB color mode is based on the CIE color model, which was developed by the CIE 
(Commission Internationale de l'Eclairage) committee. The CIE color model is based on 
the properties of color that the human eye can see. Regarding the LAB model, the L 
stands for the luminance of color. The A represents how green or red the color is. Stated 
another way, the A represents the range of red and green color components. The B 
represents how blue or yellow the color is, or stated another way, represents a range of 
blue and yellow color components. You may want to work in the LAB color mode if your 
image is for print because there isn't as much color shift when you convert the color 
mode to CMYK. Photoshop uses the LAB color mode as an intermediate step when you 
convert RGB to CMYK. You can also use the LAB color mode's luminance component 
to convert color images to grayscale.  

As you notice in the Color Picker, along with each of the color mode abbreviations, there 
are associated numbers. Some of the numbers are designated in percentages, such as the 
CMYK value and the specific part of the HSB model. The RGB and LAB modes just 
have a number. These number values allow you and the computer to work with color in a 
numerical way.  

Before you start making color adjustments in Photoshop, you'll need to consider some 
factors that can assist you with the visual approach to evaluate and make decisions about 
the color adjustments of an image.  

Color adjustments  
Start with an image that at first glance appears to be a good one with no obvious 
problems. It's easier to learn how to make color adjustments on a good image before you 
tackle one with problems. Why would you make color adjustments on an image that 
looks okay? The answer is that all digital images straight from a camera or scanner can be 
improved due to the technical aspects of image capture, such as tonal compression and 
color casts.  

When you first open an image, evaluate it in terms of its overall appearance, image 
lighting, tonality, and color. You can use an image of your choice or save the Cactus.jpg 
file to your computer to use as an example figure while following the lesson.  



 

The provided image is saved with the RGB profile because the final output is for the 
Web. Depending on your color settings, when you open the example image in Photoshop, 
the Embedded Profile Mismatch dialog box may appear, as shown in Figure 2-2.  

 
Figure 2-2: Embedded Profile Mismatch dialog box.  

Overall appearance  

With the image open in Photoshop, first consider the overall appearance. These include 
fixing spots, blemishes, cropping, and other changes to accomplish your vision of the 
image.  



 

You can use the Notes tool (Annotation feature) to add notes to an image.  

 

To add an annotation to an image, select the Notes tool from the toolbox, click the image, 
and then type a note. To delete an annotation, select a note with the Move tool, and then 
press Delete. To delete all annotations simultaneously, click the Clear All button on the 
options bar.  

Overall lighting  

The second characteristic to evaluate is the overall lighting of the image. Image lighting 
is described in one of three ways: high-key, low-key, and average-key. These terms are 
derived from traditional photography, and are described as follows:  

• High-key: Has little or no shadow area.  
• Low-key: Has high contrast with more dark than light areas. High- and low-key 

images usually evoke a mood and are dramatic.  
• Average-key: Has both shadows and highlights. The cactus image is an example 

of an average-key image.  

Tonality  

The third characteristic to evaluate is the tonality of the image. The tonal range describes 
the number of tones or values and the brightness and contrast of the image. To help you 
visualize the tonal range of an image, think about a grayscale gradient going from black 
to white in 256 steps. This also relates to lighting image types. For example, a low-key 
image has the highest concentration of tones in the low to middle (black to middle gray) 
range and very few highlights (white). The numerical values for the highlights of an 
adjusted image are generally between 80 and 96. As you recall, 255 is the value for 
white. For a good tonal quality of an average adjusted image, the darkest tones should be 
around 10 and the highlights around 244. When you're evaluating overall tones, you can 
also check the tonal range and the amount of detail in the grayscale image of each of the 
colors in the Channels palette.  

You can usually evaluate the contrast of the image, but it's not as easy to perceive the 
distribution of the tones in the image. Photoshop provides a graphical representation of 
your image, called a histogram, that does just that. The histogram shows a graphical chart 
of the tonal range or distribution of the pixels and the number of pixels at each brightness 
value in your image.  



Color  

The fourth characteristic to evaluate in your image is color. Look for visual color casts or 
other color balance issues and color saturation.  

Histogram palette  
The histogram in Photoshop CS2 has its own palette and is located in the palette group 
with the Navigator and Info palettes. If you're using an earlier version of Photoshop (prior 
to CS), the histogram is in a dialog box that you access from the Image menu. Although it 
doesn't include all of the information that you find in the CS versions, it's still a valuable 
tool.  

The Levels dialog box also has a histogram. As a separate palette, you can view the 
graphical representation of the tonal distribution of your image and the amount of pixels 
at each brightness value during the image editing process. In the Histogram palette, you 
can also see channels view and other histogram statistics. The real power of the 
Histogram palette is that it works similarly to a separate live preview as you make tonal 
adjustments to your image. To make it easier to use the palette to monitor the changes in 
the histogram, you can separate it from its group and select the expanded view from the 
palette menu.  

Use the cactus histogram, as shown in Figure 2-3, to learn how to interpret the graph.  

 
Figure 2-3: Histogram for cactus image.  

The peaks of the graph are high, which indicates that there's enough pixel data, but the 
tonal range is compressed. You can also see there isn't as much data on the highlight end 
of the tonal range, as indicated by the very thin line at the right end of the graph. When 
you move the mouse over the graph with the palette in extended view (as shown in Figure 
2-3), it gives you the number of pixels (count) at any given brightness value (level).  



After reviewing this example, you can visualize a low-key image histogram with the 
majority of the pixels at the left end of the graph and a high-key image with the majority 
of the pixels at the right end. If your visual evaluation of the image determines it's an 
average key but the pixels appear mostly on the left, that's an indication that the image is 
underexposed. If it's overexposed, pixels will appear mainly on the right end of the chart. 
If there's a sharp peak at one end or the other, this can mean that the pixels were clipped 
from the extreme shadow or extreme highlight area. Small gaps or spikes indicate abrupt 
tonal changes.  

The histogram is just another means of evaluating and understanding the data of your 
image to help you decide how to proceed with tonal adjustments. It does need to be 
interpreted in context of the total image. You can have a less-than-ideal histogram and 
still have a great image.  

Tonal adjustments  
On the basis of the histogram view and the overall appearance for the cactus average-key 
image example, a tonal range adjustment is a good starting point to improve the image. 
The example image is lacking in contrast with the majority of the tones or values in the 
middle gray to black area and not many in the highlight area.  

In general, to increase the contrast, you increase the darks and highlights so there's a 
greater difference between the tones. This allows the dark areas and the highlights to be 
more noticeable, creating dimension in the image. The focal point, or point of interest, in 
the image is where there is the greatest contrast between darks and the lights. After 
increasing the darks and lights, increase the brightness to show more detail.  

In the cactus example, there appears to be enough dark tones, but it's the light areas that 
need to increase. However, you need to be able to use an adjustment that increases only 
the highlights. This automatically rules out using the Brightness/ Contrast adjustment 
because it applies the same amount of correction to both the darks and the highlights. The 
Levels and Curves adjustments give you the range of adjustments you need for the 
example image.  

If an image requires adjustments to both the darks and lights and you decide to use the 
Brightness/ Contrast adjustment, start with the contrast first and fine-tune with the 
brightness.  

The Brightness/ Contrast adjustment may result in poor image quality and is not 
recommended for high-end print output.  

You can apply adjustments on a current layer with the adjustment commands located in 
the Image menu or you can create a special separate layer called an adjustment layer. The 
adjustment layer method adds all the benefits of using layers and more. When you create 
an adjustment layer without any selections in your image, it adds a layer mask, indicating 



the complete image is selected. If you have an active selection when you create an 
adjustment layer, you'll see the selection in the layer mask icon. These layer masks are 
indicated by a second thumbnail to the right of the layer thumbnail, as shown in Figure 2-
4. You'll learn more about layer masks in Lesson 3.  

 

 
Figure 2-4: Adjustment layer in Layers palette.  

A separate adjustment layer has many advantages:  

1. Contains only the correction data and does not alter the pixels until layers are 
merged or flattened  

2. Editable during image editing process and you have the option to save the layer 
with the file for future edits  

3. Affects all the visible layers below it  
4. Prevents accumulated data loss because the pixels are altered only when layers 

merge  
5. Hides layers to quickly see a before and after of the image  
6. Changes one type of an adjustment to another with a layer command  
7. Discards layer, leaving the pixels unaltered  
8. Copies and pastes an adjustment layer to a similar image file that requires the 

same adjustment  
9. Applies an adjustments layer effect on part of the image with a layer mask  

Make adjustments to levels 

The Levels dialog box includes a histogram and adds controls (sliders) for you to 
independently adjust the pixel brightness values of the tonal range of the darks or 
shadows, the midtones, and the highlights. Other options include the ability to save an 
adjustment and set specific options in the output section to define specific values for the 
printing press. The Auto button applies an automatic adjustment, which is the same as 



using Auto Levels from the Image menu. When you click the Options button, the Auto 
Color Corrections Options dialog box appears. The settings in this dialog box control the 
automatic settings in the Levels, Curves, and Brightness/ Contrast features, and the other 
auto options located in the menus. For more information about the Auto Color 
Corrections settings, consult Photoshop Help.  

Here's how the Levels adjustment works. When you move the black (0) and white (255) 
Input Levels sliders to line up with the beginning of the pixel data in the histogram and 
apply the change, the original pixel values change to black-and-white pixel values. For 
example, when you move the black Input Levels slider to the right and until the 
corresponding input value number is 25, all of the pixels at the brightness value of 25 and 
less will change to 0 (black). This results in a greater number of pixels at the dark end of 
the tonal range, resulting in an increase in contrast.  

Use the Cactus.jpg file to practice making a tonal adjustment with a Levels adjustment 
layer, as follows:  

1. Open the original Cactus.jpg file that you saved to your computer and select an 
appropriate color profile.  

2. Duplicate the image, and then save the duplicate as Cactus_practice1.psd. Leave 
the original file open for comparison.  

3. If necessary, open the Histogram palette, Layers palette, and the Info palette.  
4. In the Layers palette, click the Create a new fill or adjustment layer button, as 

shown in Figure 2-5, and then select Levels from the shortcut menu. 
Alternatively, you can select Layer > New Adjustment Layer >Levels.  

 
Figure 2-5: Create a new adjustment layer.  

As you can see in Figure 2-6, the histogram in the Levels dialog box shows the same data 
as the Histogram palette.  



 
Figure 2-6: Levels dialog box and Histogram palette comparison.  

»Enlarge image  

First, you'll experiment with a few adjustments, observe the information in the dialog 
box, watch the live update in the Histogram palette, preview where the shadows and 
highlights occur in the image as you move the sliders, and observe the before and after 
values in the Info palette.  

To make adjustments, do the following:  

1. Verify that the Preview checkbox is checked in the Levels dialog box.  
2. Move the black Input Levels slider, which is the one on the left, toward the 

middle. As you move the slider, notice the changes in your image and the live 
update of the graph in the Histogram palette. The histogram in the palette shows 
the pixel distribution for the current adjustment. Notice how the number changes 
in the Input Level box. It represents the value of the pixels at that point in the 
tonal range.  

3. As you move the black Input Levels slider to help identify the location of the 
shadows, press Alt. You can move the white Input Levels slider while pressing 
Alt to identify the highlights.  

4. Select the Eyedropper tool, and then move it over the image with the sample size 
set to Point Sample. You'll see two sets of numbers in the RGB section on the 
Info palette, as shown in Figure 2-7. The one on the left is the original value, and 
the one on the right is the changed value.  



 
Figure 2-7: The Info palette with the before and after values.  

»Enlarge image  

Notice that the numbers above the input range are also changed within a few pixels. This 
is because a proportionate adjustment is applied to the pixels. As you recall with the 
Brightness/ Contrast adjustment, an equal amount of adjustment is applied.  

Now that you've explored the Levels dialog box, you'll adjust the cactus example, as 
follows:  

1. Press Alt to change the Cancel button to the Reset button, and then click Reset to 
reset the adjustments.  

2. Move the black Input Levels slider to the right at the start of the slope of the 
graph, which is approximately the input value of 10. Move the white Input Levels 
slider to the left until it is even with the start of the data beginning of the slope.  

3. Readjust the midtones input slider to increase the brightness. The midtones range 
(gamma) is from 0.10 to 1.00.  

As you can see in the Histogram palette, the new settings show the pixels are spread over 
a wider range with more pixels in the shadows and highlights, which increases the 
contrast of the image with just a small amount of brightness in the midtones. You can 
adjust your sliders to produce an image that you'll like, which can be totally different 
from the example.  

4. Click OK, and then compare the original and adjusted images. Figure 2-8 shows a 
comparison with 20 for the black point, 0.81 for the brightness, and 203 for the 
white point.  



 
Figure 2-8: Before and after adjustment.  

5. After completing the adjustment, close both files.  

The first tonal adjustment is complete for this image. With this average-key cactus 
example, the Levels adjustment method did a good job of increasing this image's contrast 
and brightness.  

The Levels adjustment might not work for every image. For example, a low-key image 
adjusted with Levels may change the image from a low-key to average-key, which might 
not portray the same message and mood of the image. There is another adjustment level 
that fits this situation called Curves, which is covered in the next section.  

Make curves adjustments 
To access the Curves dialog box, select Image > Adjustments > Curves. The Curves 
dialog box, shown in Figure 2-9, includes a graph of a straight line at 45 degrees on a 
grid. This is a different representation of the image data than in the Levels dialog box.  



 
Figure 2-9: Curves dialog box.  

In the Levels dialog box, the x-axis (horizontal) of the graph is the range of tones from 0 
to 255 and the y-axis (vertical) is quantity of pixels. The pixel data (brightness value and 
number of pixels) for the image is plotted on the graph. Therefore, you can tell how many 
pixels match a particular brightness value or intensity at a given point in the image. When 
you shift the range of the tones by moving the input sliders and apply the change, you see 
a new histogram (graph) that shows the new distribution of pixels. Photoshop does the 
math for you.  

In comparison, Curves plots different data. The difference is in the y-axis (vertical). In 
the Curves dialog box, the y-axis presents the values (0 to 255) of the output or the 
adjustment change. The x-axis represents in input or original values (0 to 255) in the 
image. The graph represents the relationship or difference of the original values and the 
new change values. Therefore, the graph starts with a straight line representing no change 
in the data. As you change the line, it adjusts, showing you a curve or other deviation 
from the straight line. Representing the input and output data on the graph allows for 
more control and the ability to fine tune the adjustment.  

The lower-left corner represents black (0, 0) and the upper-right is white (255) at the 
position of (255, 255). The center of the straight-line graph is the midtone gray (128, 128) 
the middle is 128 gray, as shown in Figure 2-10.  



 
Figure 2-10: Detail of Curves dialog box.  

To lighten an image, move the line or curve up toward the light end and to darken an 
image, and then move it down. In Figure 2-11, you can see the relationship of the original 
midtone (128) and the new value, which results from moving the curve up a small 
amount.  



 
Figure 2-11: Curve change in the midtone.  

The gradient bars at the bottom and the left side are additional visuals that show the black 
to white tonal range goes from left to right and from bottom to top. This is the default 
orientation for an RGB image. If you're working with a CMYK image, you can reverse 
the direction of the gradient curves, which helps visualize the ink coverage. Click the 
arrows in the middle of the bottom gradient bar to switch the direction. Also, when you're 
working in CMYK, the numbers represent percentages of the four colors.  

The secret to success with Curves is to make small adjustments to the curve using the 
arrow keys on the keyboard instead of the mouse.  

Now let's put this new knowledge into practice and use Curves to adjust the midtones of a 
low-key image to lighten it.  

1. Open the Low-key_landscape.jpg image, and then select an appropriate color 
profile. Make a duplicate image, and then save it as Lowkey_landscape.psd.  

2. If necessary, open the Histogram and the Layers palettes.  
3. Click the Create a new fill or adjustment layer button at the bottom of the Layers 

palette, and then select Curves.  
4. Press Alt, and then click inside the grid to change it to 10-percent increments 

instead of 25-percent increments.  
5. Click the lower squares at the bottom-right corner of the dialog box to enlarge the 

view.  



6. Click in the middle of the graph where the input and output values are equal to 
establish a point. For precision and ease of use, press the up arrow key to move 
the curve up, which brightens the image. Alternately, you can drag with the 
mouse, but this often causes too much change.  

7. If you want, you can experiment further with the curve adjustments. You can 
press Alt to change the Cancel button to Reset, and then click the Reset button to 
reset the curve back to the original straight line.  

8. Save your changes to Lowkey_landscape.psd, and then close both files.  

Not only can you use Curves for a tonal adjustment, you can also use Curves for greater 
control for a color balance adjustment.  

In the next example, you'll use the Color Sampler tool with a 3 x 3 sample size to pick 
colors in an image and remap them to a set of new values that you set in eyedropper tools 
of the Curves dialog box.  

You'll need to identify the highlights and shadows in the Mountain_scene.jpg image. You 
can do this in one or two ways. For the first way, you can use the Threshold adjustment 
and Info palette as a guide to help read the values before you create the Curves 
adjustment layer. When you're finished, you can either hide the Threshold layer or delete 
it. With the second way, while you're in the Curves adjustment layer, you can drag the 
mouse in areas of your image to help identify the highlights and shadow areas. In this 
exercise, you'll identify the highlights and shadows using Threshold.  

To use Curves to adjust color balance, do the following:  

1. Open the Mountain_scene.jpg file, duplicate it, and then save it as 
Mountains_practice1.psd.  

2. Select the Color Sampler tool from the toolbox. On the options bar, set the 
Sample Size to 3 by 3 Average.  

3. Create a Threshold adjustment layer to help establish the lights and darks.  
4. Use the Info palette as a guide to help locate the exact area for your shadows. 

With the Color Sampler tool, mark a target area on your image. Locate the 
highlighted areas, and then click to mark the target area. If you wish, you can 
locate and target a gray area in the image.  

5. Create the Curves adjustment layer, and then double-click the Set Black Point 
eyedropper. The Color Picker appears. Use an RGB value at or near 10 for the 
shadows for this average-key scene. Click OK.  

6. Double-click the Set White Point eyedropper, enter 240 for the highlight value, 
and then click OK.  

7. Select the Set Black Point eyedropper, and then click your target area on your 
image.  

8. Repeat the process for the highlights.  

You can either do the same process for the midtones and even further fine-tune the image 
by adjusting the curve in the midtone area.  



Small adjustments work best, and use the arrow keys.  

If you don't save the settings for the eyedropper tools when prompted, you'll have to reset 
them if you reset the Curves.  

Now with your knowledge about color, tonal and color adjustments with Levels and 
Curves, and some practice, you'll be changing your good images into great images.  

 


